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บทคดัย่อ 

 

   การวิจยัเรืÉ องคลืÉนสมองได้รับความสนใจมาโดยตลอด ส่วนมากเป็นการวิจยัทางการแพทยเ์พืÉอ

วิเคราะห์หาสาเหตุของโรคต่างๆ โดยดูจากสัญญาณคลืÉนสมองทีÉเป็นสัญญาณทางไฟฟ้าขนาดเล็ก เกิดขึÊน

จากการทาํงานของสมองทาํให้มีกระแสไฟฟ้าอ่อนๆ รอบศีรษะ การวิจยัทางการแพทยพ์บว่าคลืÉนสมอง

สามารถใชจ้าํแนกภาวะทีÉแตกต่างกนัได ้เช่น ภาวะเขา้สู่การมีสมาธิ ภาวการณ์หลบัใน ภาวะทีÉมีความตัÊงใจ

สูง และภาวะทีÉมีการการพริบตา เป็นตน้ โดยสัญญาณคลืÉนสมองนีÊจะถูกนาํไปแยกตามความถีÉ เป็นสญัญาณ

ทีÉมีชืÉอเรียกต่างกนั ŝ ชืÉอ ไดแ้ก่ Delta Theta Beta Alpha และ Gamma นกัวิจยัสามารถหยิบสัญญาณต่างๆ นีÊ

เขา้มาใชป้ระโยชน์ในการจาํแนกคลืÉนสมองออกมาเป็นลกัษณะทีÉบอกภาวะต่างๆ กนัได ้อย่างไรก็ตามการ

เชืÉอมโยงข้อมูลต่างๆ นัÊนจะอยู่บนการเชืÉอมต่อกับคอมพิวเตอร์เป็นหลกั ซึÉ งต้องการทรัพยากรทัÊ งการ

ประมวลสัญญาณ ระบบปฏิบติัการ และโปรแกรมคอมไพลส์ัญญาณ ในลกัษณะทีÉนิยมเรียกวา่ BCI (Brain-

Computer Interface)  

   งานวิจยัทีÉผ่านมาใช้ BCI เพืÉอให้คอมพิวเตอร์แปลความหมายของสัญญาณคลืÉนสมองเพืÉอแปล

ความหมาย หาการจาํแนกสัญญาณออกเป็นกลุ่ม และส่งสิÉงทีÉแยกแยะไดต้่อไปยงัอุปกรณ์ต่างๆ ทาํให้การ

สัÉงงานจากคลืÉนสมองโดยตรงไปยงัอปุกรณ์ต่างๆ เป็นเรืÉองทีÉยุ่งยากมาก ดว้ยแนวคิดนีÊ โครงการวิจยัจึงเสนอ

แนวทางทีÉจะพัฒนาโมดูลไมโครคอนโทรเลอร์ทีÉสามารถรับการสัÉงงานจากคลืÉนสมองได้โดยตรง ทาํให้

อุปกรณ์ หุ่นยนต์ หรือเครืÉองจกัรสามารถทาํงานไดท้นัทีเมืÉอไดรั้บสัญญาณคลืÉนสมองทีÉถูกตอ้ง การพฒันา

โมดูลนีÊจะทาํให้เกิดการเชืÉอมต่อระหว่างสมองกบัอุปกรณ์โดยตรง ทีÉไม่ตอ้งผ่านเครืÉองคอมพิวเตอร์ หรือ

สามารถเรียกการเชืÉอมต่อนีÊว่า BDI (Brain-Devices Interface) การใช ้BDI นีÊ จะทาํให้อุปกรณ์ หรือหุ่นยนต์

สามารถทาํงานตามความตอ้งการของสมองไดโ้ดยตรง ซึÉ งจะเป็นกา้วต่อไปสู่การเปลีÉยนแปลงอุปกรณ์ต่างๆ 

ทีÉมีให้สามารถสัÉงงานผ่านสมองไดท้ันที และผูวิ้จัยจะใช้ไมโครคอนโทรเลอร์ทีÉหาซืÊอได้ตามท้องตลาด

ทัÉวไป ราคาถูก ขนาดเลก็และประหยดัพลงังาน เพืÉอมารองรับการประมวลสัญญาณคลืÉนสมอง โดยพฒันา

ใหส้มองสามารถสัÉงการเปิด-ปิดประตูจาํลองได ้ทัÊงนีÊ จะเป็นการส่งสัญญาณโดยตรงจากอุปกรณ์วดัสัญญาณ

สมองไปยงัไมโครคอนโทรเลอร์เพืÉอสัÉงมอเตอร์เปิด-ปิดทนัทีโดยไม่ตอ้งผา่นคอมพิวเตอร์ 
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Abstract 

 

   The research on the topics of brainwave has gained a lot of attention from all researchers. Most 

research topics are in the area of medical science that aim to analysis the cause of abnormal diagnose. 

With the small amount of electrical signals generated from brain functions, the researchers can interprest 

these signals into some useful information for distinguishing the difference between normal and abnormal 

conditions such as level of meditation, sleeping condition, attention, eye blinking, etc.  In general, 

brainwave signals have been filtered on frequency domains into 5 categories including Delta, Theta, Beta, 

Alpha, and Gamma. Researchers analyze these 5 signals in order to link between the differenct condition 

of human and the characteristic of these signals. As a result, the need of high computational resources for 

signal processing with efficient operating system, named as BCI ( Brain-Computer Interface) , is 

complusary for researchers in this topic.    

   In literature, the use of BCI to interpret the brainwave signals is not widely applicable.  This is 

because it requires a high performance computer with many interfaces from human to computers. 

Therefore, this research project propose the development of microcontroller module that can be controlled 

by brainwave signals.  It will be useful to develop any robotic devices to response immediatedly from 

human brain.  This microcontroller module will be functioned without the use of computer as named by  

BDI (Brain-Devices Interface) .  This research project use the on-the-shelf microcontroller that is cheap, 

small and energy saving.  This research project develop the door model to open or close by using the 

command from brainwave. The microcontroller module received signal directly from brainwave detecting 

device and then directly control motor to open or close without passing through any computer.  
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บททีÉ 1 บทนํา 

 

1.1  ความสําคัญ ทีÉมาของปัญหาทีÉทําการวจิัย  

การวิจัยเรืÉ องคลืÉนสมองได้รับความสนใจมาโดยตลอด ส่วนมากเป็นการวิจัยทางการแพทยเ์พืÉอ

วิเคราะห์หาสาเหตุของโรคต่างๆ โดยดูจากสัญญาณคลืÉนสมองทีÉเป็นสัญญาณทางไฟฟ้าขนาดเลก็ เกิดขึÊน

จากการทาํงานของสมองทําให้มีกระแสไฟฟ้าอ่อนๆ รอบศีรษะ การวิจยัทางการแพทยพ์บว่าคลืÉนสมอง

สามารถใชจ้าํแนกภาวะทีÉแตกต่างกนัได ้เช่น ภาวะเขา้สู่การมีสมาธิ ภาวการณ์หลบัใน ภาวะทีÉมีความตัÊงใจ

สูง และภาวะทีÉมีการการพริบตา เป็นตน้ โดยสัญญาณคลืÉนสมองนีÊ จะถูกนาํไปแยกตามความถีÉ เป็นสญัญาณ

ทีÉมีชืÉอเรียกต่างกนั ŝ ชืÉอ ไดแ้ก่ Delta Theta Beta Alpha และ Gamma นกัวิจยัสามารถหยิบสัญญาณต่างๆ นีÊ

เขา้มาใชป้ระโยชน์ในการจาํแนกคลืÉนสมองออกมาเป็นลกัษณะทีÉบอกภาวะต่างๆ กนัได ้อย่างไรก็ตามการ

เชืÉอมโยงข้อมูลต่างๆ นัÊนจะอยู่บนการเชืÉอมต่อกับคอมพิวเตอร์เป็นหลกั ซึÉ งต้องการทรัพยากรทัÊ งการ

ประมวลสัญญาณ ระบบปฏิบติัการ และโปรแกรมคอมไพลส์ัญญาณ ในลกัษณะทีÉนิยมเรียกวา่ BCI (Brain-

Computer Interface)  

งานวิจัยทีÉผ่านมาใช้ BCI เพืÉอให้คอมพิวเตอร์แปลความหมายของสัญญาณคลืÉนสมองเพืÉอแปล

ความหมาย หาการจาํแนกสัญญาณออกเป็นกลุ่ม และส่งสิÉงทีÉแยกแยะไดต่้อไปยงัอุปกรณ์ต่างๆ ทาํให้การ

สัÉงงานจากคลืÉนสมองโดยตรงไปยงัอุปกรณ์ต่างๆ เป็นเรืÉองทีÉยุ่งยากมาก ดว้ยแนวคิดนีÊ โครงการวิจยัจึงเสนอ

แนวทางทีÉจะพฒันาโมดูลไมโครคอนโทรเลอร์ทีÉสามารถรับการสัÉงงานจากคลืÉนสมองได้โดยตรง ทาํให้

อุปกรณ์ หุ่นยนต์ หรือเครืÉองจกัรสามารถทาํงานไดท้นัทีเมืÉอไดรั้บสัญญาณคลืÉนสมองทีÉถูกตอ้ง การพฒันา

โมดูลนีÊจะทาํให้เกิดการเชืÉอมต่อระหว่างสมองกบัอุปกรณ์โดยตรง ทีÉไม่ตอ้งผ่านเครืÉองคอมพิวเตอร์ หรือ

สามารถเรียกการเชืÉอมต่อนีÊว่า BDI (Brain-Devices Interface) การใช้ BDI นีÊ จะทาํให้อุปกรณ์ หรือหุ่นยนต์

สามารถทาํงานตามความตอ้งการของสมองไดโ้ดยตรง ซึÉ งจะเป็นกา้วต่อไปสู่การเปลีÉยนแปลงอุปกรณ์ต่างๆ 

ทีÉมีให้สามารถสัÉงงานผ่านสมองไดท้ันที และผูวิ้จยัจะใช้ไมโครคอนโทรเลอร์ทีÉหาซืÊอได้ตามทอ้งตลาด

ทัÉวไป ราคาถูก ขนาดเลก็และประหยดัพลงังาน เพืÉอมารองรับการประมวลสญัญาณคลืÉนสมอง  

จากการสาํรวจปริทรรศน์วรรณกรรมทีÉผ่านมาพบว่ายงัไม่มีงานวิจยัใดทีÉจะศึกษาและพฒันาโมดูลใน

ลกัษณะนีÊ  เพราะงานวิจยัส่วนใหญ่จะพฒันาวิธีการจาํแนกสัญญาณคลืÉนสมองเพืÉอการวินิจฉัยโรคและการ

บอกพฤติกรรมของมนุษยเ์ป็นหลกัซึÉ งไม่ไดเ้ชืÉอมต่อเขา้กบัอุปกรณ์หรือหุ่นยนต์จริง และหลายงานวิจยัทีÉตอ้ง

อาศยัการทาํงานของเครืÉองคอมพิวเตอร์โดยไม่พฒันาลงบนไมโครคอนโทรเลอร์ ถึงแมว้่าจะมีบางงานวิจยัทีÉ

ใชไ้มโครคอนโทรเลอร์แต่กเ็ป็นเพียงการส่งสญัญาณคลืÉนสมองผ่านไปเท่านัÊนไม่ไดมี้การประมวลสัญญาณ
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เพืÉอสัÉงงานอุปกรณ์ ดงันัÊนการทาํวิจยัเรืÉองนีÊ จึงเป็นเรืÉองทีÉน่าจะให้ความสําคัญเร่งด่วนเพราะสามารถสร้าง

องค์ความรู้ทนักับการพฒันาประเทศและเป็นปัญหาทีÉน่าสนใจทีÉเกิดขึÊนจริงในปัจจุบนั ทาํให้เพิÉมโอกาส

แข่งขนัในระดบัสากลมากขึÊน ซึÉ งผลสําเร็จจากการวิจยันีÊ จะช่วยให้สร้างแนวทางพฒันางานวิจยัใหม่ๆ ใน

หลายดา้น และสามารถสร้างนวตักรรมทีÉเป็นฝีมือของคนไทย ทาํให้งานวิจยันีÊสอดคลอ้งกบันโยบายและ

ยทุธศาสตร์การวิจยัของ และยงัสอดคลอ้งกบัแผนงานวิจยักบัยุทธศาสตร์การพฒันาประเทศตามแผนพฒันา

เศรษฐกิจและสงัคมแห่งชาติ  

นอกจากนีÊผลสาํเร็จของโครงการวิจยัยงัสามารถต่อยอดวิจยัเพืÉอประยกุตใ์ชก้บัอุปกรณ์อิเลก็ทรอนิกส์

ทุกชนิดในชีวิตประจาํวนั เพิÉมโอกาสให้ผูป่้วยหรือผูพิ้การสามารถใช้งานอุปกรณ์ต่างๆได้สะดวกขึÊน อนั

เป็นการยกระดบัคุณภาพชีวิตของกลุ่มเป้าหมาย ดว้ยการพฒันาองค์ความรู้จากนักวิจยัในประเทศไทย จาก

การสาํรวจวรรณกรรมทีÉผ่านมาพบว่าเทคนิคทีÉเสนอในงานวิจยันีÊ เป็นเรืÉองใหม่ทีÉยงัไม่เคยมีงานวิจยัใดเสนอ

มาก่อน นอกจากนีÊ ผูว้ิจยัยงัพฒันาเทคนิคดงักล่าวในลกัษณะเป็นการสร้างโปรแกรมประมวลผลสัญญาณ

คลืÉนสมองบนไมโครคอนโทรเลอร์ แลว้พฒันาจนเป็นตน้แบบทีÉสามารถใชง้านไดจ้ริง ถือวา่เป็นแนวทางใน

การพฒันาทีÉนําไปสู่การสร้างฐานรากงานวิจยัของอุตสาหกรรมดา้นเทคโนโลยีทีÉทนัสมยัของประเทศ จึง

สอดคลอ้งกบัยุทธศาสตร์ทีÉ ř : การเพิÉมขีดความสามารถในการแข่งขนัของประเทศ เพืÉอหลุดพน้จากประเทศ

รายได้ปานกลาง (Growth & Competitiveness) ประเด็นหลกัทีÉ  Š. การวิจัยและพฒันา และสอดคลอ้งกับ

นโยบาย/เป้าหมายของรัฐบาล เรืÉอง Š. การพฒันาและส่งเสริมการใชป้ระโยชน์จากวิทยาศาสตร์ เทคโนโลยี 

การวจิยัและพฒันาและนวตักรรม 

1.2 วตัถุประสงค์ของโครงการวจิัย 

1. เพืÉอศึกษาองคค์วามรู้ของการสัÉงงานดว้ยสญัญาณคลืÉนสมอง 

2. เพืÉอพฒันาตน้แบบโมดูลไมโครคอนโทรเลอร์ทีÉสัÉงงานดว้ยคลืÉนสมอง 

3. เพืÉอสร้างเทคโนโลยีใหม่ทีÉมีศกัยภาพในการแข่งขนักบัต่างประเทศได ้ 

1.3 แนวทางการดาํเนินการวิจัย 

ř. ศึกษาสัญญาณคลืÉนสมอง ด้วยการจาํลองแบบในคอมพิวเตอร์ ณ ห้องปฏิบัติการ FŜ ศูนย์

เครืÉองมือฯ มหาวทิยาลยัเทคโนโลยีสุรนารี 

Ś. ศึกษาโมดูลไมโครคอนโทรเลอร์ทีÉสามารถรับสัญญาณคลืÉนสมองได ้โดยใชก้ารจาํลองแบบดว้ย

โปรแกรม MATLAB ณ หอ้งปฏิบติัการ FŜ ศูนยเ์ครืÉองมือฯ มหาวทิยาลยัเทคโนโลยีสุรนารี 

ś. ออกแบบและสร้างการเชืÉ อมต่อโมดูลไมโครคอนโทรเลอร์กับสัญ ญาณ คลืÉนสมอง ณ 

หอ้งปฏิบติัการ FŜ ศูนยเ์ครืÉองมือฯ มหาวทิยาลยัเทคโนโลยีสุรนารี 
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Ŝ. พัฒนาและทดสอบเบืÊ องต้นของโมดูลทีÉ เสนอขึÊ น ณ ห้องปฏิบัติการ FŜ ศูนย์เครืÉ องมือฯ 

มหาวทิยาลยัเทคโนโลยีสุรนารี 

ŝ. พฒันาและสร้างตน้แบบโมดูลไมโครคอนโทรเลอร์ทีÉสัÉงงานดว้ยคลืÉนสมอง ณ ห้องปฏิบติัการ 

FŜ ศูนยเ์ครืÉองมือฯ มหาวทิยาลยัเทคโนโลยีสุรนารี 

Ş. เก็บผลการทดสอบโมดูลเมืÉอนาํไปประยุกตใ์ชง้านจริง ณ พืÊนทีÉบริเวณห้องปฏิบติัการ อาคารศูนย์

เครืÉองมือ มหาวทิยาลยัเทคโนโลยีสุรนารี 

ş. วเิคราะหผ์ลการทดสอบ และเปรียบเทียบกบัแนวทางทีÉเสนอไวใ้นงานวิจยัอืÉนๆ   

Š. พฒันา ปรับปรุง แกไ้ข เพืÉอใหไ้ดผ้ลตามวตัถุประสงคที์Éวางไว ้

š. เสนอบทความในงานประชุมวชิาการ 

řŘ. นาํขอ้เสนอแนะในงานประชุมวิชาการมาปรับปรุงงานวิจยั 

řř. สรุปผลสาํเร็จของโครงการและทาํรายงานโครงการ 

1.4 ผลสําเร็จของโครงการ 

ประโยชน์ทีÉคาดว่าจะได้รับคือการเผยแพร่ผลงานวิจยันีÊ ในงานประชุมวิชาการระดบันานาชาติ ř 

บทความ ซึÉ งเป็นการนาํองค์ความรู้ทีÉไดจ้ากงานวิจยันีÊ เผยแพร่แก่นกัวิจยัทีÉทาํงานใกลเ้คียงกนั ทาํให้สามารถ

นาํไปพฒันาต่อยอดสําหรับงานวิจยัอืÉนๆ ได ้ซึÉ งหน่วยงานวิจยัทางโทรคมนาคมในประเทศไทยสามารถนาํ

ผลงานดงักล่าวไปใชไ้ด ้ 

1.5 การสํารวจปริทรรศน์วรรณกรรมทีÉเกีÉยวข้องกับโครงการวิจัย 

ทีÉผ่านมา การวิเคราะห์สัญญาณสมองทางประสาทวิทยาไดรั้บความสนใจเป็นอย่างมาก เห็นไดช้ัด

จากความสําเร็จในการรักษาโรคลมชัก โรคทางสมอง และโรคสมองตายทีÉไดถู้กตีพิมพใ์น [ř] โดนเฉพาะ

อย่างยิÉงในช่วงปี ค.ศ. řšŠŘ การวิเคราะห์คลืÉนสมองถูกใชเ้ป็นครัÊ งแรกในการออกแบบการตอบโตร้ะหว่าง

มนุษยแ์ละหุ่นยนต์ หรือทีÉ เรียกว่า Human Machine Interface (HMI) และรวมไปถึงการโตต้อบกนัระหว่าง

สมองและคอมพิวเตอร์ หรือ Brain-Computer Interface (BCI) [Ś] ทีÉแสดงการเชืÉอมต่อโดยตรงผ่านการ

วิเคราะห์สัญญาณสมองจากการเก็บสัญญาณผ่านโพรบหลายๆ อัน ระบบ BCI คือระบบการสืÉอสารทีÉไม่

ขึÊนกบัการกระทาํจากเส้นประสาทและกลา้มเนืÊอ [ś] การทดลองการใชค้ลืÉนสมองมีขึÊนครัÊ งแรกทีÉแสดงให้

เห็นการเลือกตัวอักษรในการสะกดคํา [Ŝ] และการทําให้ตัวชีÊ บนหน้าจอเคลืÉอนทีÉ  [ŝ] ในปัจจุบัน การ

ประยุกต์ใช้งานระบบ BCI ไดถู้กนาํมาใชช่้วยเหลือผูพิ้การ ตวัอย่างเช่น การควบคุมรถเข็นดว้ยความคิด [Ş] 

และการประยุกต์อุปกรณ์ในบ้านอัจฉริยะ [ş, Š] สําหรับระบบ BCI สัญญาณสมองจะถูกบันทึกและ

ประมวลผลในลกัษณะทนัทีทนัใดและถูกเปลีÉยนเป็นสญัญาณคาํสัÉงทีÉส่งออกไปยงัอุปกรณ์เชืÉอมต่อภายนอก 
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หรือหน้าจอคอมพิวเตอร์ ซึÉ งการประมวลผลสัญญาณตอ้งอาศัยทัÊงสมการเชิงเส้นและไม่เชิงเส้น [Ś, š] 

นอกจากนีÊ  สัญญาณ EEG จะมีลกัษณะจาํเพาะในแต่ละสถานการณ์ จึงไดมี้การนาํเอาอลักอริทึมบางอย่างมา

ปรับใชเ้พืÉอกระการของ BCI เป็นไปตามความตอ้งการของผูใ้ชง้าน ERP คือผลตอบสนองของคลืÉนสมองทีÉ

เกิดจากการกระตุน้ภายนอกเช่น การมองเห็น การสัมผสั การไดยิ้น การไดก้ลิÉน หรือการรับรส ในขณะทีÉ 

SMR คือการสัÉนตวัในช่วงความถีÉ Š ถึง śŚ Hz ทีÉเกิดระหว่างการทาํงานของมอเตอร์และการจินตนาการ [š] 

ในบางหอ้งทดลองไดมี้การพฒันาระบบ BCI ทีÉทาํให้ผูใ้ช้งานมีชีวิตทีÉดีขึÊน Kübler et al ไดเ้สนอแนวคิดใน 

[řŘ] ทีÉพฒันาการประยุกต์ระบบ BCI ทีÉให้หนา้จอแสดงออกมาตาม ERP หรืออีกงานทีÉ Miranda et al ทีÉได้

แสดงถึงความเป็นไปไดใ้นการสร้างอุปกรณ์สําหรับการสันทนาการ และการรักษาโรค [řř] โดยการเสนอ

ให้ใช้สัญญาณ EEG ดว้ยระบบ BCI เพืÉอทาํการแสดงดนตรี และไดมี้การเสนอแนวคิดของระบบ BCI ทีÉมี

การโตต้อบกนัระหว่างผูใ้ช้งานกบัหุ่นยนต์ หุ่นยนต์ Ś ตวัจะติดหลอดไฟ LED ทัÊงหมด Š ดวงซึÉ งจะทาํให้

ผูใ้ชง้านสามารถกาํหนดการเคลืÉอนไหวของหุ่นยนตไ์ด ้

 จากการสํารวจงานวิจัยทีÉเกีÉยวข้องพบว่ายงัไม่มีการพัฒนาเชืÉอมต่อสัญญาณคลืÉนสมองตรงไปยงั

อุปกรณ์ทีÉจะสัÉงงาน หรือเรียกว่า BDI (Brain-Device Interface) เพราะส่วนใหญ่ตอ้งอาศยัการประมวลผล

จากเครืÉ องคอมพิวเตอร์ทีÉ มีโปรแกรมและทรัพยากรเหลือเฟือ แต่ในโมดูลไมโครคอนโทรเลอร์นัÊ นมี

ทรัพยากรทีÉจาํกดัทาํให้การใชง้าน BDI จึงไม่เหมือนกนั BCI ซึÉ งถือเป็นความทา้ทายของโครงการวจิยันีÊ และ

ยงัไม่เคยมีงานวิจยัใดนาํเสนอมาก่อน 
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บททีÉ 2 ทฤษฏแีละความรู้ทีÉเกีÉยวข้อง 

 

 

2.1 กล่าวนํา 

คลืÉนไฟฟ้าสมอง (Electroencephalogram) ทีÉใช้ในทางการแพทยส่์วนมากจะทําการวดัทีÉหนังศีรษะ

ดงันัÊนเราจึงเห็นเฉพาะคลืÉนไฟฟ้าสมองทีÉมีความแรงพอทีÉจะผ่านเยืÉอหุม้สมอง กะโหลกและผิวหนงัศีรษะได้

คลืÉนไฟฟ้าสมองทีÉวดัไดส่้วนมากเกิดจากการรวมกนัของประจุทีÉบริเวณ Dendrite ซึÉ งก่อให้เกิดการกระตุ้น

หรือการยบัยัÊงของเซลล์ประสาท (Excitatory & Inhibitory Postsynaptic Potentials , EPSP & IPSP) ทีÉอยู่ติด

ผิวนอกของสมอง (Cortex) และแทบจะไม่ไดเ้กิดจาก Action potential ซึÉ งเป็นประจุทีÉเกิดบริเวณ Axon เลย

ทัÊ งนีÊ เนืÉ องจาก Action potential ซึÉ งเกิดในส่วนลึกจะเกิดไม่พร้อมกันในแต่ละเซลล์ ทําให้ขนาดของ

สนามไฟฟ้าทีÉ เห็นได้ทีÉผิวสมองมีขนาดเล็ก เมืÉอรวมกับระยะเวลาของ Action Potential ซึÉ งน้อยกว่าหรือ

เท่ากบัหนึÉงในพนัของวินาที ทาํใหเ้ราไม่สามารถตรวจวดั Action Potential ทีÉผิวสมอง ตรงกนัขา้มกบั EPSP 

และ IPSP ทีÉมีการกระจายของประจุกวา้งในชัÊนของ Dendrite ซึÉ งอยูตื่Êน รวมทัÊงการเปลีÉยนแปลงเกิดขึÊนอย่าง

ชา้ๆเราจึงสามารถวดัการเปลีÉยนแปลงนีÊไดม้ากกว่าทาํให้คลืÉนไฟฟ้าสมองเกิดจากการรวมกนัของประจุทีÉ

บริเวณทีÉ Dendrite เป็นสาํคญั  

จากการทีÉเราสามารถวดัคลืÉนสมองทีÉบริเวณหนังศีรษะได้จากเครืÉองวดัคลืÉนไฟฟ้าสมองEEGเรา

สามารถควรคุมการกระพริบตาและการคิดเพืÉอทีÉจะนาํมาใชใ้นการควบคุมอุปกรณ์เปิด-ปิดประตูโดยใชก้าร

สัÉงการดว้ยการกระพริบตาและการใชค้วามคิดในการเปิดประตู 

 

2.2 การกาํเนิดคลืÉนไฟฟ้าสมองปกตทิีÉเกดิเป็นจังหวะ ( RHYTHMIC EEG ACTIVITY ) 

ในคลืÉนไฟฟ้าสมองปกติจะมีการเปลีÉยนแปลงเป็นจงัหวะ ( Rhythmic ) เช่น ในผูใ้หญ่จะมี 8-13 Hz 

Sinusoidal Background Activity การเปลีÉยนแปลงนีÊ เกิดจากประจุทีÉ  Dendrite ได้รับสัญญาณจากตวักาํเนิด

จังหวะทีÉอยู่ใน Thalamus ผ่าน Projecting Fiber เข้ามาก่อให้เกิด EPSP และ IPSP ทีÉ  Dendrite ของเซลล์

ประสาทบริเวณผิวสมอง (Cortical neuron) เป็นบริเวณกวา้ง คลืÉนไฟฟ้าสมองขณะตืÉน หลบัตา และกาํลงัพกั

จะมีคลืÉนทีÉเกิดเป็นจงัหวะ ทัÊงทีÉสมองมีการทาํงานทีÉซับซ้อนต่างๆมากมาย เชืÉอกนัว่าตวักาํหนดจงัหวะของ

คลืÉนไฟฟ้าสมองทีÉสาํคญัทีÉสุดอยูที่É Thalamus ปรากฏการณ์อีกอยา่งหนึÉงทีÉสาํคญัต่อความเขา้ใจใน 
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แหล่งกาํเนิดของคลืÉนไฟฟ้าสมอง ไดแ้ก่การเกิด Desynchronization ซึÉ งหมายถึงการลดลงหรือหายไป

ของคลืÉนสมองทีÉเป็นจงัหวะ เช่น ในกรณีทีÉผูถู้กวดัลืมตา หรือเริÉมใชค้วามคิด หรือเมืÉอง่วงนอน เชืÉอวา่กลไก

สําคัญคือ Reticular Activating System (RAS) ซึÉ งอยู่ในก้านสมอง โดยปกติระบบนีÊ จะไดรั้บสัญญาณจาก

ระบบรับสัมผสัต่างๆ และส่วนต่างๆของสมอง และจะส่งสัญญาณไปสู่เนืÊอสมองทัÊงโดยตรงและโดยผ่าน 

Diencephalon  

2.2.1 การวดัคลืÉนไฟฟ้าสมองดว้ยขัÊวไฟฟ้าทีÉหนงัศีรษะ ( Recording of EEG with Scalp  Electrodes ) 

คลืÉนไฟฟ้าสมองทีÉวดัไดที้Éหนงัศีรษะมีลกัษณะสาํคญั 3 ประเภท คือ  

1. ส่วนมากเป็นผลรวมจากการเปลีÉยนแปลงทางไฟฟ้าสมองทีÉอยู่ใกลข้ัÊวไฟฟ้านัÊนๆ 

2. ส่วนนอ้ยเกิดจากการเปลีÉยนแปลงทางไฟฟ้าในบริเวณทีÉห่างไกล 

3. เยืÉอหุม้สมองและกะโหลกศีรษะมีคุณสมบติัเป็นตวักรองโดยลดสญัญาณความถีÉสูง 

การหาทีÉมาของสัญญาณในทางประสาทสรีรวิทยา (Electrophysiology) นัÊนทาํโดยการเปรียบเทียบ

รูปร่างสัญญาณกับเวลาทีÉ เกิดจากสัญญาณจากตําแหน่งต่างๆว่าเหมือนกันเพียงใด เรียกว่าการหา

ความสัมพนัธ์ (Correlation) ระหว่างสัญญาณจากสองตาํแหน่งนัÊนส่วนมากเราจะพบว่าคลืÉนไฟฟ้าสมองทีÉ

หนงัศีรษะจะมีรูปร่างคลา้ยกบัคลืÉนไฟฟ้าจากผิวสมอง (Electrocorticogram, ECG) ทีÉอยู่ใกล ้ในบางกรณีเรา

พบว่ามีความสัมพันธ์ระหว่าง EEG กับแหล่งกําเนิดสัญญาณในบริเวณทีÉ ห่างไกล พบว่าแหล่งกําเนิด

สญัญาณนีÊมกัจะมีลกัษณะพิเศษไดแ้ก่  1 ) มีขนาดสัญญาณใหญ่และมีการเรียงตวัของเนืÊอสมองในลกัษณะทีÉ

ทําให้ประจุมารวมกัน (High intensity, spatial orientation) จนสามารถเห็นได้จากทีÉ ห่างไกล เราเรียก

ปรากฏการณ์นีÊ ว่ามีการฉายสัญญาณ (Projection) จากบริเวณทีÉห่างไกลไปยงัขัÊ วทีÉ ใช้วดั หรือ 2 ) มีการ

ต่อเชืÉ อมผ่านใยประสาทเพืÉอมาควบคุมเนืÊ อสมองทัÊ งสองข้างพร้อมๆกัน (Bilateral Synchrony) ซึÉ ง

แหล่งกาํเนิดสัญญาณทีÉกระจายออกไปยงัสมองทัÊงสองพร้อมๆกนันีÊมกัอยู่ในส่วนกลางของสมอง ในกรณีทีÉ

สองสัญญาณจะมาจากเนืÊอสมองทีÉอยู่ใต้ขัÊววดันัÊนเอง ในทัÊงสองกรณีสัญญาณไฟฟ้าทีÉมีจุดเริÉมทีÉห่างไกล

เหล่านีÊ ถูกเรียกว่า Projected rhythm ตัวอย่างทีÉเห็นไดช้ดัทางคลินิกคือการเกิด Sharp Wave จากสมองส่วน 

Hippocampus และเนืÊอสมองโดยรอบนัÊนห่างจากขัÊววดัทีÉ Temporal Lope หลายเซนติเมตร แต่ก็ยงัสามารถ 

Project มาทีÉขัÊววดัได ้

เยืÉอหุม้สมองและกะโหลกศีรษะมีคุณสมบติัเป็นตวักรองลดสัญญาณความถีÉสูงลง ( High Frequency 

Filter ) การลดทอนของสัญญาณนีÊ เกิดเพิÉมขึÊนเมืÉอความหนาของเยืÉอหุม้และกะโหลกมากขึÊน กบัเมืÉอมกีาร “ 

ลดัวงจร” โดยมีสารทีÉนาํไฟฟ้าไดดี้เช่น Subdural Blood มาขวางระหวา่งสมองและขัÊวไฟฟ้า 
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สัญญาณใดๆก็ตามทีÉมีแหล่งกาํเนิดนอกเนืÊอสมอง เราถือว่าเป็นสัญญาณรบกวน (Artifacts) ตามทีÉจะ

ไดก้ล่าวต่อไป ตัวอย่างเช่น ไฟฟ้าจากกลา้มเนืÊอหรือจากการกลอกลูกตาซึÉ งจะมาทาํให้คลืÉนไฟฟ้าสมองมี

ลกัษณะเปลีÉยนแปลงไป เป็นตน้ 

2.2.2 เครืÉองขยายสญัญาณ (Amplifier) 

เครืÉองขยายสัญญาณมีหน้าทีÉหลกั 2 อย่างคือ คัดเลือกสัญญาณคลืÉนไฟฟ้าสมองออกจากสัญญาณ

รบกวน และขยายสญัญาณคลืÉนไฟฟ้าสมอง 

การคัดเลือกสัญญาณคลืÉนไฟฟ้าสมองออกจากสัญญาณรบกวน ( Discrimination ) เนืÉ องจาก

สัญญาณไฟฟ้าทีÉบันทึกได้จากหนังศีรษะนอกจากประกอบด้วยคลืÉนไฟฟ้าสมองแล้วยงัมีสัญญาณจาก

สิÉงแวดลอ้มอืÉนๆ ซึÉ งอาจมีขนาดเท่ากบัหรือใหญ่กวา่สัญญาณคลืÉนไฟฟ้าสมอง แต่มกัมีการกระจายตวัทีÉกวา้ง

กล่าวคือกระทบส่วนต่างๆของร่างกายเท่าๆกัน ดังนัÊนถา้เรานาํสัญญาณจากสองจุดมาหักลบกนั สัญญาณ

รบกวนจะหมดไปเหลือแต่สัญญาณทีÉต่างกนัระหว่างสองขัÊวเท่านัÊน     ( Differential Amplification ) เครืÉอง

ขยายสัญญาณแต่ละช่องจึงถูกสร้างใหมี้ขัÊวรับสัญญาณสองขัÊวเรียกวา่ Input 1 และ Input 2 ( Grid 1 , Grid 2 

) โดยวดัสัญญาณเทียบกบัจุดเปรียบเทียบเรียกว่า Ground สัญญาณจากขัÊวทีÉสองจะถูกกลบัขัÊวแลว้นาํไปรวม

กบัสญัญาณจากขัÊวทีÉหนึÉง  

2.2.3 สญัญาณรบกวน ( Artifacts ) 

การบนัทึกและตีความสัญญาณคลืÉนไฟฟ้าสมองทีÉมีขนาดเล็กมากนัÊน ทัÊงผูบ้นัทึกและผูอ้่านแปลผล

ตอ้งระวงัวา่สัญญาณทีÉเรากาํลงัศึกษานัÊนเกิดจากสมองหรือเป็นสัญญาณรบกวนจากสัญญาณไฟฟ้าทีÉ 

เกิดขึÊ นในร่างกายหรือสิÉ งต่างๆรอบข้าง สัญญ าณ รบกวนในการตรวจคลืÉนไฟฟ้าสมองคือ

สญัญาณไฟฟ้าใดๆทีÉเครืÉองบนัทึกไดแ้ต่ไม่ไดเ้กิดจากสมอง โดยแบ่งไดเ้ป็น 2 กลุ่ม คือ  

สญัญาณรบกวนทีÉเกิดจากร่างกาย ( Physiological Artifacts )  

ก. เกิดจากการเคลืÉอนไหวของศีรษะ ร่างกาย หรือการเต้นของชีพจร ( Movement Artifacts 

and Pulse Artifact) 

ข. สญัญาณไฟฟ้าจากร่างกาย ( Bioelectrical Potentials ) ไดแ้ก่ 

 1. การเคลืÉอนไหวของลูกตา ( Eye Movement Artifacts ) 

 2. การเคลืÉอนไหวของลิÊน ( Tongue Movement Artifacts ) 

 3. การหดตวัของกลา้มเนืÊอ ( Muscle Artifacts ) 

 4. การเตน้ของหวัใจ ( EKG Artifacts ) 

 5. การหดตวัของกลา้มเนืÊอกลอกตา ( Lateral Rectus Artifacts ) 

ค. การเปลีÉยนความตา้นทานของผิวหนงั ( Sweet Artifacts and Vasomotor Activity ) 
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รูปทีÉ  2.1  แสดง Physiologic artifacts จากการลืมตา กระพริบตา หรือการเคลืÉอนไหวของตา 

(ตาํราการตรวจคลืÉนไฟฟ้าสมอง) 

 

สญัญาณรบกวนทีÉไม่ไดเ้กิดจากร่างกาย ( Non Physiological Artifacts ) เกิดจาก 

ก.  สญัญาณรบกวนจากเครืÉองใชไ้ฟฟ้า ( External Electrical Interference ) 

ข.  สัญญาณรบกวนจากการทาํงานผิดพลาดภายในเครืÉองตรวจคลืÉนไฟฟ้าสมอง ( Internal Electrical 

Malfunction of the Recording System ) 

 

2.3 โปรแกรมใช้เขียนคําสัÉงบอร์ด ARDUINO  

 ในทีÉนีÊ เราจะเขียนโปรแกรมโดยใช้ภาษา C โดยใช้ Arduino IDE เป็นชุดโปรแกรมหลักในการ

พฒันา 

2.3.1 Arduino IDE (Arduino Integrated Development Environment ) 

Arduino IDE  เป็นเครืÉองมือทีÉเราจะใช้เขียนคาํสัÉงต่างๆผ่านโปรแกรม Arduino IDE เพืÉอทีÉจะใช้ใน

การสัÉงบอร์ด Arduino และในโปรแกรม Arduino IDE ยงัสามารถดู Serial Monitor ภายในโปรแกรมของ

ตวัเองไดโ้ดยไม่ตอ้งเรียกโปรแกรมอืÉนมาเสริมในการดู Serial Monitor 
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รูปทีÉ  2.2  โปรแกรม Arduino IDE  

[ http://www.arduitronics.com ] 

 

2.3.2 ขัÊนตอนการใชง้านโปรแกรม Arduino IDE 

1. เปิดโปรแกรม Arduino ทีÉไดโ้หลดมาจาก http://arduino.cc/en/Main/Software 

2. เมืÉอเปิดโปรแกรมแลว้จะพบกบัหนา้ต่างของ IDE ดงัรูป 

 
รูปทีÉ  2.3 ขัÊนตอนการใชง้านโปรแกรม Arduino IDE 

[ http://www.ec.in.th/index.php?route=cms/article&article_id=34 ] 
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3. ไปทีÉ Tools->Board แลว้เลือกใหต้รงกบับอร์ดทีÉใชง้าน สาํหรับ Arduino Mega2560 ใหเ้ลือกบอร์ด 

Arduino Mega2560 

4. เขียนโปรแกรมคาํสัÉงภาษาซีทีÉเราจะใหบ้อร์ด Arduino MegaŚŝŞŘ ทาํงาน 

void setup() { 

Serial.begin(9600); 

} 

void loop() { 

Serial.print("Hello World\n\r"); 

} 

 

5. จากนัÊนคอมไฟลโ์ปรแกรมโดยไปทีÉ Sketch->Verify / Compile 

 
รูปทีÉ  2.4 ขัÊนตอนการใชง้านโปรแกรม Arduino IDE 

[ http://www.ec.in.th/index.php?route=cms/article&article_id=34 ] 
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Ş. เมืÉอคอมไฟลเ์รียบร้อยจะมีขอ้ความปรากฏดงัรูป 

 
รูปทีÉ  2.5 ขัÊนตอนการใชง้านโปรแกรม Arduino IDE 

[ http://www.ec.in.th/index.php?route=cms/article&article_id=34 ] 

7. ต่อบอร์ด Arduino Mega2560 เขา้กบัคอมพิวเตอร์ผา่นทางพอร์ต USB 

 

 
รูปทีÉ  2.6  ขัÊนตอนการใชง้านโปรแกรม Arduino IDE 

[ http://www.ec.in.th/index.php?route=cms/article&article_id=34 ] 
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8. จากนัÊนใหไ้ปทีÉ Tools->Serial Port และเลือกใหต้รงกบับอร์ด Arduino Mega2560ทีÉใชง้าน  

 
รูปทีÉ  2.7  ขัÊนตอนการใชง้านโปรแกรม Arduino IDE 

[ http://www.ec.in.th/index.php?route=cms/article&article_id=34 ] 

 

9. โหลดโปรแกรมเขา้บอร์ด Arduino Mega2560 โดยไปทีÉ File->Upload 

 
รูปทีÉ  2.8 ขัÊนตอนการใชง้านโปรแกรม Arduino IDE 

[ http://www.ec.in.th/index.php?route=cms/article&article_id=34 ] 
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řŘ. จากนัÊนเปิด Serial Monitor ของ Arduino IDE โดยไปทีÉ Tools->Serial Monitor 

 
รูปทีÉ  2.9 ขัÊนตอนการใชง้านโปรแกรม Arduino IDE 

[ http://www.ec.in.th/index.php?route=cms/article&article_id=34 ] 

 

11. เมืÉอเปิด Serial Monitor จะไดข้อ้ความดงัรูป 

 
รูปทีÉ  2.10 ขัÊนตอนการใชง้านโปรแกรม Arduino IDE 

[ http://www.ec.in.th/index.php?route=cms/article&article_id=34 ] 

2.4 ARDUINO MEGA2560 

 Arduino Mega2560 บอร์ดรุ่นใหญ่ในของตระกูล Arduino มีคุณสมบติัต่างๆ เพิÉมขึÊนจาก Arduino 

Uno R3 ใชชิ้พ ATmega2560 ทีÉมีหน่วยความจาํ 256 KB แรม 8 KB ใชไ้ฟเลีÊยง 7 ถึง 12 V แรงดนัของระบบ
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อยู่ทีÉ 5 V มี Digital Input / Output มากถึง 54 ขา (เป็น PWM ได ้14 ขา) มี Analog Input 16 ขา Serial UART 

4 ชุด I2C 1 ชุด SPI 1 ชุด เขียนโปรแกรมบน Arduino IDE และโปรแกรมผ่าน USB เหมาะสาํหรับผูที้Éสนใจ

เริÉมต้นเรียนรู้การพฒันาไมโครคอนโทรลเลอร์ทีÉตอ้งการบอร์ด Arduino ทีÉมีหน่วยความจาํและขาสัญญาณ

ต่างๆ ใหต่้อใชง้านมากขึÊน 

 
รูปทีÉ  2.11 Arduino Mega2560 [ http://www.arduitronics.com ] 

รายละเอียดคุณสมบติัของ Arduino Mega2560 

Operating Voltage 5V 

Input Voltage (recommended) 7-12V 

Input Voltage (limits) 6-20V 

Digital I/O Pins 54 (of which 14 provide PWM output , 4 UART TTL) 

Analog Input Pins 16 

DC Current per I/O Pin 40 mA 

DC Current for 3.3V Pin 50 mA 

Flash Memory 256 KB of which 8 KB used by bootloader 

SRAM 8 KB 

EEPROM 4 KB 

Clock Speed 16 MHz 
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2.5 BLUETOOTH SERIAL MODULE (HC-05 MASTER/SLAVE MODE) 

 โมดูล Bluetooth รุ่น HC-05 ทาํให ้Arduino มีความสามารถสืÉอสารแบบไร้สายโดยใช ้Bluetooth ใช้

งานง่ายด้วยอินเตอร์เฟส Serial Port เขียนโปรแกรมโดยสัÉงผ่าน Serial Port ทัÉวไป จ่ายไฟ 3.3V ให้กับ 

Module Bluetooth HC-05 แลว้ต่อขา RX กบั TX ไปทีÉ Arduino ก็สามารถเพิÉมความสามารถสืÉอสารไร้สาย

ผ่าน Bluetooth ให้ Arduino ไดแ้ลว้ สามารถสัÉงงานควบคุมจากอุปกรณ์ทีÉมี Bluetooth เช่น เครืÉองคอมหรือ

โทรศพัทม์ือถือทีÉมี Bluetooth ได ้

 
รูปทีÉ  2.12 Bluetooth Serial Module (HC-05 Master/Slave mode) 

[ http://pixgallarehd.com/arduino+bluetooth+hc-05 ] 

 

2.5.1 ขัÊนตอนการใชง้าน Bluetooth Serial Module (HC-05 Master/Slave mode) 

การต่อสายระหวา่ง Arduino  กบั Bluetooth HC-05 

 

HC-05    Arduino 

VCC  -->    5V 

Rx  -->    D7 

Tx  -->    D6 

KEY  -->    D5 

GND  -->    GND 
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รูปทีÉ  2.13 การต่อสายระหวา่ง Arduino  กบั Bluetooth HC-05 

[ http://www.arduinothai.com ] 

2.5.2 การกาํหนดให ้HC-Řŝ ทาํงานเป็น MasterและตัÊงค่าเพืÉอใหเ้ชืÉอมต่อกบั Headset EEG 

1. ต่อ Arduino เขา้กบัคอมพิวเตอร์ แลว้ใช ้โคด้ตามนีÊ  ไปยงั Arduino IDE เพืÉอทาํการเขา้โหมด AT 

Command 

 

#include <SoftwareSerial.h> 

SoftwareSerial BTSerial(6, 7); // RX | TX 

void setup() 

{ 

pinMode(5, OUTPUT);  // this pin will pull the HC-05 pin 34 (key pin) HIGH to switch module to 

AT mode 

  digitalWrite(5, HIGH); 

  Serial.begin(9600); 

  BTSerial.begin(9600);  // HC-05 default speed in AT command more 

  delay(1000); 

  Serial.println("Enter AT commands:"); 

} 

void loop() 

{ 

  // Keep reading from HC-05 and send to Arduino Serial Monitor 

  if (BTSerial.available())  
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Serial.write(BTSerial.read()); 

  // Keep reading from Arduino Serial Monitor and send to HC-05 

  if (Serial.available()) 

    BTSerial.write(Serial.read()); 

} 

 

2. เปิดหนา้ต่าง Serial Monitor ตัÊงค่า Baud Rate เป็น šŞŘŘ และเลือก Both NL&CR ดงัรูป         

 
รูปทีÉ  2.14 การกาํหนดให ้HC-Řŝ ทาํงานเป็น Master 

 [http://www.arduinothai.com ] 

 

3. พิมพ ์AT แลว้กด Send หรือ Enter ก็จะคาํว่า OK แสดงออกมาให้เห็นทีÉ Serial Monitor  หากไม่มี

การตอบสนอง ใหต้รวจสอบการต่อสายต่าง ๆ ตรวจสอบทีÉตวั HC-05 วา่มีปุ่ มอะไรใหก้ดหรือไม่(ลองกดปุ่ ม

ดู) หากยงัไม่มีการตอบสนอง ใหปิ้ดหนา้ต่าง Serial Monitor แลว้กลบัไปทาํตามขอ้  2 

4. พิมพ ์AT+ROLE=1 เพืÉอกาํหนดให ้HC-05 ทาํหนา้ทีÉเป็น Master 

5. พิมพ์ AT+ROLE? เพืÉอตรวจสอบให้แน่ชัดว่าเป็น Master Mode จริงๆ ค่าทีÉแสดงออกมาจะเป็น 

+ROLE:ř เป็นการเสร็จสิÊนการตัÊงค่า Master 

6. พิมพ ์AT+BIND=(ตามดว้ย MAC Address)  จะไดค้าํสัÉงตามนีÊ  AT+BIND=2068,9d,a84e6f MAC 

Address เอามาจากค่าทีÉ เราเก็บจากการดู MAC Address ของ Headset EEG เพืÉอให้ Bluetooth HC-05เห็น

อุปกรณ์ Headset EEG 
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รูปทีÉ  2.15 MAC Address MindWave  

 

7. ใช้คําสัÉงAT+PAIR=(ตามด้วย MAC Address)  เพืÉอให้  Bluetooth HC-05 จับแค่  MAC Address 

ของ Headset EEG เพียงตวัเดียวเท่านัÊน โดยใชค้าํสัÉง AT+PAIR= 2068,9d,a84e6f 

8. ใชค้าํสัÉง AT+LINK=(ตามดว้ย MAC Address)  เพืÉอให ้ Bluetooth HC-05 ทาํการเชืÉอมต่อแค่ MAC 

Address ของ Headset EEG เพียงตวัเดียวเท่านัÊน โดยใชค้าํสัÉง AT+LINK=2068,9d,a84e6f 

 

2.6 MINDWAVE 

 เป็นอุปกรณ์ทีÉใช้ส่งคลืÉนสัญญาณ EEG ผ่าน Bluetooth มายงั Arduino MegaŚŝŞŘ เพืÉอประมวลผล

และทาํตามคาํสัÉงเงืÉอนไขของ Code ทีÉอยู่ใน Arduino MegaŚŝŞŘ  ตวั MindWave จะมีเซ็นเซอร์ตรวจวดัคลืÉน

สมองแบบแห้งโดยไม่ตอ้งใชเ้จลเป็นตวักลางให้ MindWave ดึงสัญญาณคลืÉนไฟฟ้าสมองจากบริเวณหนัง

ศีรษะซึÉงง่ายต่อการใชง้าน MindWave ใชถ้่าน AAA เพียง1กอ้นในการเป็นแหล่งพลงังานและมีนํÊาหนกั 90 g 

สามารถใช้งานไดน้านถึง 8 Hr. และ Bluetooth สามารถใช้งานไดไ้กลถึง 10 m เราสามารถนาํ MindWave 

มาใชก้บัอุปกรณ์อืÉนทีÉสามารถเชืÉอมต่อ Bluetooth ไดเ้ช่น โทรศพัทมื์อถือ, เครืÉองคอมพิวเตอร์, Note Book, 

Tablets นอกเหนือจากการตรวจวดัคลืÉนสมอง EEG ยงัสามารถ ตรวจจบัการกระพริบตาเนืÉองจากรูปแบบ
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คลืÉนการกระพริบตาจะมีความต่างจากคลืÉนสมองทัÉวไปตามรูปทีÉ2.1 และเครืÉองสามารถวดั Attention ความ

ส นใจ  Meditation การทําสมาธิ  Spectrum (Alpha, Beta ) ค วามเข้มข อง Alpha, Beta จาก การดูผ่ าน 

Application ของทางบริษทั Neurosky 

 
 

รูปทีÉ  2.16 ตวัเครืÉอง MindWave  [http://store.neurosky.com/products/mindwave-1 ] 

2.6.1 วิธีการใชง้าน MindWave 

1. เลืÉอนตวัเซ็นเซอร์ทีÉติดหนา้ผากออกมา 

 
รูปทีÉ  2.17 เลืÉอนตวัเซ็นเซอร์ทีÉติดหนา้ผากออกมา 

 [http://support.neurosky.com/kb/mindwave/how-to-properly-wear-the-mindwave ] 

2. สวมตวั MindWave โดยหนัหนา้เขา้เหมือนในรูปทีÉ 2.18 
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รูปทีÉ  2.18 สวมตวั MindWave โดยหนัหนา้เขา้เหมือนในรูป 

 [http://support.neurosky.com/kb/mindwave/how-to-properly-wear-the-mindwave ] 

 

3. หนีบตวัเซ็นเซอร์ทีÉหูขา้งซา้ย  

 
รูปทีÉ  2.19 หนีบตวัเซ็นเซอร์ทีÉหูขา้งซา้ย 

[ http://support.neurosky.com/kb/mindwave/how-to-properly-wear-the-mindwave ] 
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4. เลืÉอนตวัเซ็นเซอร์ทีÉหนา้ผากมาให้แตะบริเวณหนา้ผากพอดี 

 
รูปทีÉ  2.20 เลืÉอนตวัเซ็นเซอร์ทีÉหนา้ผากมาใหแ้ตะบริเวณหนา้ผากพอดี  

[ http://support.neurosky.com/kb/mindwave/how-to-properly-wear-the-mindwave ] 

 

5. เปิดปุ่ ม Power โดยเลืÉอนปุ่มไปทีÉ ON และถา้หากจะทาํให้เครืÉองคน้หาอุปกรณ์ทีÉจะเชืÉอมต่อให้

ดันปุ่มขึÊ นทีÉ  ON ค้างไว ้5 วินาทีและปล่อยถ้าไฟสีนํÊ าเงินหยุดกระพริบแสดงว่าเครืÉองทาํการ

เชืÉอมต่อกนัแลว้ 

 
รูปทีÉ  2.21 เปิดปุ่ม Power และการเชืÉอมต่อ 
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[ http://support.neurosky.com/kb/mindwave/how-to-properly-wear-the-mindwave ] 

2.7 โมดลูรีเลย์ 

 
รูปทีÉ  2.22 ลกัษณะวงจรโมดูลรีเลย ์

[ http://thaieasyelec.com ] 

 

 รีเลย ์(Relay) เป็นอุปกรณ์ไฟฟ้าชนิดหนึÉง ซึÉ งทาํหนา้ทีÉตดัต่อวงจรแบบเดียวกบัสวิตช์ โดยควบคุม

การทาํงานดว้ยไฟฟ้า Relay มีหลายประเภท ตัÊงแต่ Relay ขนาดเล็กทีÉใช้ในงานอิเล็กทรอนิกส์ทัÉวไป จนถึง 

Relay ขนาดใหญ่ทีÉใชใ้นงานไฟฟ้าแรงสูง โดยมีรูปร่างหน้าตาแตกต่างกนัออกไป แต่มีหลกัการทาํงานทีÉ

คลา้ยคลึงกนั สาํหรับการนาํ Relay ไปใชง้าน จะใชใ้นการตดัต่อวงจร ทัÊงนีÊ  Relay ยงัสามารถเลือกใชง้านได้

หลากหลายรูปแบบ ภายในรีเลยจ์ะประกอบไปดว้ยขดลวดและหนา้สัมผสั  

 หน้าสัมผสั  NC (Normally Close) เป็นหน้าสัมผสัปกติปิด โดยในสภาวะปกติหน้าสัมผสันีÊ จะต่อ

เขา้กบัขา COM (Common) และจะลอยหรือไม่สัมผสักนัเมืÉอมีกระแสไฟฟ้าไหลผา่นขดลวด 

หนา้สัมผสั NO (Normally Open) เป็นหนา้สัมผสัปกติเปิด โดยในสภาวะปกติจะลอยอยู่ ไม่ถูกต่อกบั

ขา COM (Common) แต่จะเชืÉอมต่อกนัเมืÉอมีกระแสไฟไหลผา่นขดลวด 

ขา COM (Common) เป็นขาทีÉ ถูกใช้งานร่วมกันระหว่าง NC และ NO ขึÊ นอยู่กับว่า ขณ ะนัÊ นมี

กระแสไฟฟ้าไหลผ่านขดลวดหรือไม่ หน้าสัมผสัใน Relay 1 ตวัอาจมีมากกว่า 1 ชุด ขึÊนอยู่กบัผูผ้ลิตและ

ลกัษณะของงานทีÉถูกนาํไปใช ้จาํนวนหนา้สมัผสัถูกแบ่งออกดงันีÊ  

 สวิตช์จะถูกแยกประเภทตามจาํนวน Pole และจาํนวน Throw ซึÉ งจาํนวน Pole (SP-Single Pole, DP-

Double Pole, 3P-Triple Pole, Etc.) จะบอกถึงจํานวนวงจรทีÉทําการเปิด-ปิด หรือ จ ํานวนของขา COM 

นัÉนเอง และจาํนวน Throw (ST, DT) จะบอกถึงจาํนวนของตัวเลือกของ Pole ตัวอย่างเช่น SPST- Single 

Pole Single Throw สวติชจ์ะสามารถเลือกไดเ้พียงอยา่งเดียวโดยจะเป็นปกติเปิด (NO-Normally Open) หรือ
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ปกติปิด (NC-Normally Close) แต่ถา้เป็น SPDT- Single Pole Double Throw สวิตช์จะมีหนึÉ งคู่เป็นปกติเปิด 

(NO) และอีกหนึÉงคู่เป็นปกติปิดเสมอ (NC) ดงัรูปดา้นล่าง 

 
รูปทีÉ  2.23 สวทิซ์โมดูลรีเลย ์

http://thaieasyelec.com 

SPST คือ Single Pole Single Throw                               

SPDT คือ Single Pole Double Throw                             

DPST คือ Double Pole Single Throw 

DPDT คือ Double Pole Double Throw 

 

 
รูปทีÉ  2.24 วงจรสมมูลของโมดูลรีเลย ์

 [ http://thaieasyelec.com ] 
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รูปทีÉ  2.25 โมดูลรีเลย ์[http://www.mltelectronic.com ] 

 

จากส่วนประกอบขา้งตน้ทีÉไดก้ล่าวไป เราจะใชง้าน Relay แบบ SPDT (Single Pole Double Throw) 

หลกัการทาํงานของ Relay นัÊน ในส่วนของขดลวด เมืÉอมีกระแสไฟฟ้าไหลผ่าน จะทาํให้ขดลวดเกิดการ

เหนีÉยวนาํและทาํหนา้ทีÉเสมือนแมเ่หล็กไฟฟ้า ส่งผลใหข้า COM ทีÉเชืÉอมต่ออยูก่บัหนา้สัมผสั NC (ในสภาวะ

ทีÉยงัไม่เกิดการเหนีÉยวนาํ) ยา้ยกลบัเชืÉอมต่อกบัหนา้สัมผสั NO แทน และปล่อยใหข้า NC ลอย เมืÉอมองทีÉขา 

NC กบั COM และ NO กบั COM แลว้จะเห็นว่ามีการทาํงานติด-ดบัลกัษณะคลา้ยการทาํงานของสวิตซ์ เรา

สามารถอาศยัคุณสมบติันีÊไปประยุกต์ใชง้านได ้

 

Specification: 

 ไฟเลีÊยงโมดูลรีเลย ์VCC = 5VDC. 

ควบคุมโหลดได้ทัÊ งแรงดันไฟฟ้า AC ได้สูงสุด 250VAC 10A หรือ แรงดันไฟฟ้า DC ได้สูงสุด 

30VDC 10A (Maximum Load) 

 ระดบัสญัญาณอินพุทควบคุมแบบ TTL ทาํงานดว้ยสัญญาณแบบ Active Low 

 กระแสขบัรีเลย ์(Drive Current) 15-20mA. 

 มีการออกแบบใหเ้ป็น Isolate ดว้ย Optocoupler 

 มี LED แสดงสถานะ Relay 

 โมดูลขนาด 3.85cm.(กวา้ง) x 5.05cm.(ยาว) x 1.85cm.(สูง) 
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2.8 หลอด LED ขนาด 5 MM 

 LED ยอ่จาก  Light  Emitting Diodes  มีให้เห็นไดท้ัÉวไปในอุปกรณ์อิเลก็ทรอนิกส์  บางครัÊ งคุณเห็น

ไดใ้นนาฬิกาดิจิตอล   รีโมทคอนโทรล  หนา้ปัดอุปกรณ์ไฟฟ้า โทรทศัน์จมัโบ ้  หรือแมแ้ต่ไฟจราจรตามสีÉ

แยกเป็นตน้ ทีÉจริงแลว้หลอด  LED  คือหลอดไฟขนาดเลก็  แต่มีหลกัการทาํงานแตกต่างจากหลอดไฟมีไส้  

เพราะวา่ไม่มีการเผาไส้หลอด  ดง้นัÊน หลอด  LED  จึงไม่เกิดความร้อน  แสงสวา่งเกิดขึÊนจากการเคลืÉอนของ

อิเลก็ตรอนภายในสารกึÉงตวันาํ  ซึÉงเป็นวสัดุแบบเดียวกบัทีÉใชใ้นการทาํทรานซิสเตอร์ 

 
รูปทีÉ  2.26 หลอด LED ขนาด 5 mm 

[ http://imerlighting.blogspot.com/2014/04/led.html ] 

 

 
รูปทีÉ  2.27 ส่วนประกอบหลอด LED ขนาด 5 mm 

[ http://industrial.hidofree.com ] 
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ตารางทีÉ 2.1 คุณสมบติัหลอด LED 

 

 

 

2.9 DIP SWITCH (DUAL INLINE PACKAGE) 

 เป็นสวิตช์ขนาดเล็กใช้งานร่วมกบัวงจรอิเล็กทรอนิกส์ทีÉสร้างขึÊนในรูปชิพ (Chip) ทีÉมีขนาดเล็กๆ 

หรือใชง้านกบัไอซี (IC = Integrated Circuit) ลกัษณะสวิตช์สามารถตดัหรือต่อวงจรได ้ การควบคุมตดัต่อ 

DIP Switch จะตอ้งใช้ปลายมปากกาหรือปลายดินสอในการปรับเลืÉอนสวิตช์  DIP Switch มกัถูกติดตัÊงบน

แผน่วงจรพิมพ ์ (Printed Circuit Board) ใชก้บักระแสไม่เกิน 30mA ทีÉแรงดนั 30VDC 

 
รูปทีÉ  2.28 DIP Switch แบบ 8 รหสั 

 [ http://www.myarduino.net ] 

 

สี 

ความยาว

คลืÉน 

( nm ) 

แรงดนัไฟฟ้า 

( v ) 

กระแส 

( mA ) 

แรงดนั

ยอ้นกลบั 

( v ) 

อายกุารใช้

งาน 

( Hr ) 

ขาว  3 v    -    3.4 10    - 20 6 50,000 

เหลือง 588  -  590 1.9 v   -  2.1 10    - 20 6 50,000 

แดง 620  -  625 1.9 v   -  2.1 10    - 20 6 50,000 

นํÊาเงิน 460  -  463 3 v     -   3.4 10   -  20 6 50,000 

เขียว 520  -  525 3 v   -  3.4 10    - 20 6 50,000 
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2.10 กล่าวท้ายบท 

ในเนืÊ อหาทัÊ งหมดของบททีÉสองจะกล่าวถึงข้อมูลพืÊนฐานทีÉมีความจาํเป็นต่อการพัฒนาอุปกรณ์

ไมโครคอนโทรเลอร์ทีÉสามารถควบคุมไดจ้ากคลืÉนสมอง โดยทีÉมีเนืÊอหาทีÉเกีÉยวข้องเป็นอุปกรณ์เชืÉอมต่อ

หลายส่วน ส่วนแรกเป็นอุปกรณ์รับส่งคลืÉนสมอง ซึÉ งจะทาํหน้าทีÉในการรับสัญญาณจากคลืÉนสมองเพืÉอส่ง

ต่อไปยงัอุปกรณ์อืÉนๆ ดว้ยสญัญาณบลูทูธ ส่วนถดัมานัÊนคือการรับสัญญาณจากสญัญาณบลูทูธเพืÉอเชืÉอมโยง

เขา้สู่การประมวลผลสัญญาณในไมโครคอนโทรเลอร์  
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บททีÉ 3 การออกแบบอลักอริทึมและการจําลองระบบ 

 

 

3.1 กล่าวนํา 

ในบทนีÊ จะกล่าวถึงการออกแบบระบบการทาํงานของประตูว่ามีขัÊนตอนการทาํงานอย่างไรตามทีÉ

แสดงในรูปทีÉ 3.1  และกล่าวถึงการเขียนโปรแกรมทีÉใช้ในการสัÉงการโดยขัÊนแรกเป็นการกระพริบตาเพืÉอ

ยืนยนัการเขา้ใชง้านระบบ จากนัÊนเป็นการกระพริบตาเขา้รหัส เมืÉอกระพริบตาเขา้รหัสถูกตอ้งตามทีÉตัÊงค่า

รหัสไวร้ะบบจะรอการยืนยนัการเปิดประตูอีกครัÊ งโดยการนําค่า  Meditation มาสร้างเงืÉอนไขเป็นขัÊนตอน

สุดท้าย ตามทีÉแสดงในรูปทีÉ  3.2  และยงัมีรูปแบบการทํางานทีÉแสดงอยู่ในรูปของ Flow Chart อธิบาย

หลกัการทาํงานอยา่งละเอียด ตามรูปทีÉ 3.2 

 
รูปทีÉ  3.1 โครงสร้างการทาํงานโดยรวม 
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รูปทีÉ  3.2 ขัÊนตอนการทาํงานของระบบโดยรวมการออกแบบอลักอริทึม 
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3.1.1 การกระพริบตาเพืÉอยนืยนัการเขา้ใชง้าน 

 
 

คาํสัÉงใน Loop นีÊจะทาํการเช็ควา่มีการกระพริบตาหรือไม ่โดยถา้มีการกระพริบตานัÊนจะเขา้ไปทาํงาน

โดยเพิÉมค่าตวัแปร “numE” ขึÊนไป 1 ค่า โดยค่าตวัแปลดงักล่าวทาํหนา้ทีÉบอกจาํนวนครัÊ งทีÉกระพริบตาและ

จะเกบ็ เวลาของการกระพริบตาครัÊ งทีÉ1และครัÊ งทีÉ4 

 

 
 

คาํสัÉงใน Loop นีÊ เป็นการสร้างเงืÉอนไขขึÊนมาเพืÉอยืนยนัว่าตอ้งการจะเริÉมใชง้านอุปกรณ์ โดยจะทาํการ

เช็คว่ามีการกระพริบตาครบ 4 ครัÊ ง และใชเ้วลาในการกระพริบตานอ้ยกว่า 7 วินาที หรือไม่ โดยถา้กระพริบ

ตาตรงตามเงืÉอนไข ตวัแปร “finish” จะเก็บค่าเป็น 0 จากนัÊนทาํการแสดงระยะเวลาทีÉกระพริบตาไดต้รงตาม

เงืÉอนไขใน “Total time” โดยแสดงออกทาง Serial Monitor และแสดง “Ready to Enter Password!!!” ใน 

Serial Monitor เช่นกนั และเขา้ไปเช็คเงืÉอนไขใน Loop While โดยเงืÉอนไขคือถา้ finish = 0 ให้ไปทาํงานทีÉ 

Loop1 ต่อไป 
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คาํสัÉงใน Loop นีÊ จะทาํการเช็ควา่มีการกระพริบตาครบ 4 ครัÊ ง และใชเ้วลาในการกระพริบตามากกว่า 

7 วินาที หรือไม่ ถา้กระพริบตาเกิน 7 วินาที ตวัแปล numE จะเคลียค่าเป็น 0 และ LED สีแดงจะกระพริบ 3 

ครัÊง จากนัÊนจะวนกลบัไปเริÉมตน้ทาํงานใหม ่เพืÉอรับค่าการกระพริบตา 4 ครัÊ งใหม ่

 

3.1.2 การกระพริบตาเขา้รหสั 

 
 

หลงัจากกระพริบตาครบ 4 ครัÊ งภายในเวลา 7 วินาทีแลว้จะเข้ามาทาํงานใน Loop การเขา้รหัส โดย

คาํสัÉงใน Loop นีÊ  ตวัแปร “i” จะเพิÉมขึÊนทุกครัÊ งทีÉเขา้มาทาํงานใน Loop โดยแสดงเป็นรหสัตวัทีÉ 1-4  จากนัÊน

จะเขา้มาเช็คเงืÉอนไขภายใน Loop การกระพริบตาวา่มีการกระพริบตาหรือไม่ ถา้มีการกระพริบตา LED ของ
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รหัสตวันัÊนๆจะติด และตวัแปร “pass” จะเก็บค่าเป็น 1 แต่ถา้ไม่มีการกระพริบตา LED ของรหัสตวันัÊนๆจะ

ไม่ติด และตวัแปร “pass” จะเกบ็ค่าเป็น 0 

 

 
 

คาํสัÉงในชุดนีÊ จะเช็คค่าตัวแปร “i” ถ้ามีค่าเป็น 1 หมายถึง Password ตวัทีÉ 1 หลงัจากนัÊนนําค่าในตัว

แปร “pass” มาเก็บไวใ้น p1 โดยถา้ p1 มีค่าเป็น 1 LEDp1 จะติด แต่ถา้ p1 มีค่าเป็น 0 LEDp1 จะไม่ติด คาํสัÉง

ในลูปนีÊจะเช็คค่าตวัแปล “i” วนถึง i มีค่าเท่ากบั 4 ซึÉ งหมายถึง Password ตวัทีÉ 4 

 

  
 

คาํสัÉงใน Loop นีÊ จะเช็คค่าตวัแปร “i” ทีÉมีค่ามากกว่า 4 โดยจะเคลียค่าตวัแปล pass และตวัแปล i เป็น 

0 และแสดง Check Password!!! ใน Serial Monitor จากนัÊนไปทาํงานทีÉ Loop2 
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3.1.3 การเชค็รหสักระพริบตา 

 
 

ใน Setup2 ( ) นัÊนจะเป็นการตงัค่า Pin Mode ของหลอด LEDทีÉใชแ้สดงค่ารหสัผ่านใหเ้ป็น OUTPUT 

และกาํหนด Pin Mode ของ S1-S4 ให้เป็น INPUT เพืÉอทีÉให้บอร์ดอ่านค่ารหสัผ่านทีÉเรากาํหนดผ่านทาง Dip 

Switch ได้ โดยใน Loop2 ( ) นัÊนจะเป็นการอ่านค่าจาก Dip Switch แล้วนําไปเก็บไวที้Éตัวแปร p1state-

p4state ซึÉ งจะนาํไปใชเ้ป็นรหสัผา่นทีÉเรากาํหนดไว ้
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คําสัÉงใน Loop นีÊ จะนําค่า Password ในตัวแปร p1-p4 มาเช็คกับค่า p1state-p4state ซึÉ งเป็นรหัสทีÉ

ไดม้ากจากการอ่านค่า Dip Switch โดยถา้รหัสแต่ละตวัตรงตามทีÉกาํหนดไว ้LEDpassC จะกระพริบสามครัÊ ง  

จากนัÊนเขา้ไปทาํงานใน Loop3 โดยใชเ้วลา 20 วินาที ถา้เกิน 20 วินาที จะหลุดจาก Loop3 

  
 

คาํสัÉงใน Loop นีÊ จะตรวจสอบว่า ถา้ค่า Password ในตวัแปร “p1-p4” มีค่าไม่เท่ากบั p1state-p4state 

หรือ Password ตัวใดตัวหนึÉ งมีค่าไม่ตรงตามรหัสทีÉตัÊ งไว ้แสดงว่ากระพริบตาใส่รหัสผิดพร้อมแสดง 

LEDpassW กระพริบสามครัÊ ง และตวัแปล “w” จะเก็บค่าเพิÉมขึÊนทุกครัÊ งทีÉใส่รหัสผิด เมืÉอใส่รหัสผิดครบ ŝ 

ครัÊ ง ตวัแปล “p1-p4” จะถูกเก็บค่าเป็น Ř ตวัแปล “numE” จะถูกเก็บค่าเป็น Ř ตวัแปล “i” จะถูกเก็บค่าเป็น Ř 

และตวัแปร “finish” จะถูกเก็บค่าเป็น ř ซึÉ งหมายถึงคาํสัÉงจบการทาํงาน โดยให้กลบัไปเริÉมตน้การกระพริบ

ตาเพืÉอยืนยนัการใชง้านใหม่ 
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3.1.4 ยืนยนัการเปิดประตูโดยใชค้ลืÉนไฟฟ้าสมอง EEG 

 
 

คาํสัÉงใน Loop นีÊจะนาํค่า Meditation มาหาร 10 แลว้นาํผลทีÉไดม้าเปรียบเทียบกบั case วา่จะตรง case 

ไหน โดยตัÊงแต่ case 0-6 หลอด LED1-7 จะติดเพิÉมขึÊนตามลาํดบั 

 

 
 

ใน case 7-10 นัÊนหลอด LEDจะติดครบทุกหลอด จากนัÊนจะเขา้ไปทาํงานทีÉ Loop4 และเมืÉอทาํงานทีÉ 

Loop4 เสร็จเรียบร้อยจะกาํหนดค่าตวัแปร “zzz” ให้มีค่าเป็น 1 โดยทีÉเมืÉอทาํงาน  จนจบ ฟังกช์นั switch แลว้

จะนาํค่า zzz ไปเช็คถา้เป็น 1 จะกลบัไปทาํงานใน Loop ต่อเท่ากบัว่าเป็นการจบการทาํงานแลว้รอรับการ

กระพริบตาเพืÉอยืนยนัการเขา้ใชง้านอีกครัÊ ง 
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3.1.5 ควบคุมการทาํงานของมอเตอร์ 

 
 

ใน Loop นีÊ เริÉมตน้มาจะสัÉงให้ DC มอเตอร์ทํางานเพืÉอเป็นการเปิดประตู โดยจะเปิดประตูทิÊงไวเ้ป็น

เวลา 5 วินาทีหลงัจากนัÊนมอเตอร์จะหมุนในทิศตรงกนัขา้มครัÊ งแรกเพืÉอปิดประตู หลงัจากปิดประตูแลว้จะ

สัÉงเปลีÉยนค่าของตวัแปร p1-p4,numE,i ใหมี้ค่าเป็น 0 เพืÉอพร้อมทีÉจะเริÉมทาํงานใหม่ 

 

  
 

หลงัจากทีÉมอเตอร์เปิดและปิดประตูเสร็จแลว้ กลบัไปทาํงานต่อใน Loop เดิม คือการเพิÉมค่า zzz ให้

เป็น ř แลม้าตรวจค่า zzz ในฟังกช์นั if  ถา้ zzz = ř ทาํการตัÊงค่าตวัแปร finish ให้เป็นř ซึÉ งก็คือการสัÉงใหจ้บ

การทาํงาน แลว้กลบัไปทาํงานใน Loop หลกัต่อ นัÉนก็คือการรอการกระพริบตาเพืÉอยืนยนัการเขา้ใชง้านครัÊ ง

ต่อไป 

 

3.2 กล่าวท้ายบท 

เนืÊ อห าบท นีÊ อ ธิบ ายถึ งอัล กอ ริทึ มทีÉ นําสัญ ญ าณ ค ลืÉ นส มองมาใช้สัÉ งการบ นชุ ดคําสัÉ งข อ ง

ไมโครคอนโทรเลอร์ โดยแบ่งเป็นขัÊนตอนแสดงรายละเอียดการทาํงานทีÉสามารถนาํไปทดสอบไดต่้อไป 
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บททีÉ 4 การทดสอบต้นแบบชิÊนงานทีÉสามารถสัÉงการด้วยสมอง 

 

4.1 กล่าวนํา 

บทนีÊ จะกล่าวถึงการทดสอบอุปกรณ์ว่าระยะทางทีÉ เพิÉมขึÊ นจะส่งผลต่อระยะเวลาในการเปิดประตู

หรือไม่  อยา่งไร และมีปัจจยัอย่างอืÉนทีÉมีผลกระทบต่อการเปิดประตูหรือไม่ โดยใหผู้ท้ดลองยืนทีÉตาํแหน่งทีÉ

ไดก้าํหนดระยะทางไวแ้ลว้ทาํการเปิดประตูตามขัÊนตอนจากนัÊนทาํการเก็บค่าระยะเวลาจาก Serial Monitor 

วา่ใชเ้วลาเท่าไหร่ โดยผูท้ดลองจะทาํการทดลองแต่ละตาํแหน่ง 5 ครัÊ งแลว้นาํค่าเวลาทีÉไดใ้นแต่ละตาํแหน่ง

มาเฉลีÉยกนั  จากนัÊนนาํเวลาเฉลีÉยของแต่ละตาํแหน่งมาเปรียบเทียบกนัวา่มีผลต่อการเปิดประตูหรือไม ่

 

4.2 อุปกรณ์การทดสอบชิÊนงาน 

ผูจ้ดัทาํไดส้ร้างโมเดลจาํลองสาํหรับประตูเลืÉอนอตัโนมติั ตามรูปทีÉ 4.1 โดยภายใตฐ้านของโมเดลมี

วงจรการทาํงานคอยควบคุมการเปิด-ปิดประตูตามรูปทีÉ 4.2 จากรูปเห็นวา่ทางผูจ้ดัทาํไดเ้จาะรูโมเดลเพืÉอสอด

หลอด LED ขึÊนมาดา้นบนฐานเพืÉอความเป็นระเบียบเรียบร้อย และสงัเกตไดง่้ายอีกดว้ย 

 

 
รูปทีÉ  4.1 โมเดลประต ู
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รูปทีÉ  4.2 รูปแบบการต่อวงจร 

 

4.3 ขัÊนตอนการทดสอบ 

1. กาํหนดระยะทางการทดสอบ 2-10 เมตร  

2. ผูท้ดลองยืน ณ ตาํแหน่ง 2 เมตร 

3. ผูท้ดลองสวม Headset EEG และทาํการ Connect Bluetooth  

4. ทดลองเปิดประตูตามขัÊนตอนโดยกระพริบตา 4 ครัÊ งเพืÉอยืนยนัการเขา้ใชร้ะบบ ต่อมาการพริบตา

เขา้รหสัตามทีÉตัÊงไว ้สุดทา้ยทาํการยืนยนัการเปิดประตูโดยใชค้ลืÉนสมอง EEG 

5. บนัทึกค่าเวลาทีÉแสดงบน Serial Monitor   

6. ทาํการทดลองซํÊาอีก 4 ครัÊง 

7. ผูท้ดลองยืนทีÉตาํแหน่งต่อไปตามทีÉกาํหนดไวที้ÉขัÊนตอนทีÉ 4.3.1 และทาํตามขัÊนตอนการทดลองทีÉ 

4.3.2-4.3.6 

8. นาํบนัทึกผลการทดลองแต่ละตาํแหน่งมาเฉลีÉยพร้อมบนัทึกผลเฉลีÉย 

4.4 ผลการทดลอง 

ผลการทดสอบถูกบนัทึกในคอมพิวเตอร์โดยสามารถแสดงตวัอย่างแสดงผลการทดลองบน Serial 

Monitor ในรูปทีÉ Ŝ.ś 
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รูปทีÉ  4.3 ตวัอยา่งแสดงผลการทดลองบน Serial Monitor 

 

ตารางทีÉ 4.1 ตารางแสดงผลการทดลองของผูท้ดลองคนทีÉ 1 

ครัÊ งทีÉ 
ระยะเวลาในการเปิดประตู (วนิาที) 

2 เมตร 4 เมตร 6 เมตร 8 เมตร 10 เมตร 

1 36 62 54 37 61 

2 52 48 44 51 45 

3 41 36 56 73 37 

4 55 42 32 54 35 

5 68 27 30 35 54 

เฉลีÉย 50.4 43 43.2 50 46.4 
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ตารางทีÉ 4.2 ตารางแสดงผลการทดลองของผูท้ดลองคนทีÉ 2 

 

ครัÊ งทีÉ 
ระยะเวลาในการเปิดประตู (วนิาที) 

2 เมตร 4 เมตร 6 เมตร 8 เมตร 10 เมตร 

1 54 48 49 64 56 

2 57 52 38 24 34 

3 36 63 64 45 25 

4 43 25 57 36 47 

5 57 46 25 47 26 

เฉลีÉย 49.4 46.8 46.6 43.2 37.6 

 

ตารางทีÉ 4.3 ตารางแสดงผลการทดลองของผูท้ดลองคนทีÉ 3 

 

ครัÊ งทีÉ 
ระยะเวลาในการเปิดประตู (วนิาที) 

2 เมตร 4 เมตร 6 เมตร 8 เมตร 10 เมตร 

1 58 36 46 57 53 

2 43 47 44 37 35 

3 64 53 36 48 34 

4 36 47 37 43 51 

5 35 24 27 45 42 

เฉลีÉย 47.2 41.4 38 46 43 

 

 

4.5 วเิคราะห์ผลการทดลอง 

จากรูปแสดงผลการทดลองทีÉ 4.1 เป็นตัวอย่างการแสดงผลทาง Serial Monitor โดยค่า PoorQuality 

คือค่าความเสถียรของสัญญาณไฟฟ้าสมอง EEG ทีÉออกมาจาก Headset  ถา้ค่า PoorQuality เป็น Ř แสดงว่า

สัญญาณมีความเสถียรมาก แต่ถ้าค่า PoorQuality มีค่ามากกว่า 0 แสดงว่าสัญญาณทีÉรับได้ไม่เสถียร [ 

http://support.neurosky.com] ซึÉ งจะส่งผลต่อการเปิดประตู โดยจะใช้เวลานานในการเปิดประตูเพราะ
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สัญญาณไม่เสถียร สิÉงทีÉทาํให้ค่า PoorQuality มีค่ามากกว่า Ř มีหลายสาเหตุ เช่น เซนเซอร์ของ Headset ไม่

แตะกบัผิวหนงัของผูท้ดลอง หรือมีเส้นผมมาบดบงัระหวา่งเซนเซอร์กบัผิวหนงั ส่วนค่า Meditation คือค่าทีÉ 

Headset ประมวลผลคลืÉนไฟฟ้าสมองใหอ้ยู่ในช่วง Ř-100 โดยถา้ค่า Meditation มีค่าเป็น Ř แสดงว่าผูท้ดลอง

ไม่มีสมาธิ แต่ถา้ค่า Meditation มีค่าเป็น 100 แสดงว่าผูท้ดลองมีสมาธิมาก  [ http://support.neurosky.com] 

ณ ทีÉนีÊ ค่า Meditation ทีÉนาํมาใชเ้ป็นเงืÉอนไขในการเปิดประตูอยูที่Éช่วง 70 ขึÊนไป ซึÉงเป็นช่วงทีÉตอ้งมีสมาธิมาก

และมีความตัÊงใจจริงๆ โดยในชีวิตประจาํวนัคลืÉนไฟฟ้าสมองของคนทัÉวไปจะมีค่า Meditation อยูที่Éช่วง 40-

60 โดยผูท้ดลองจะตอ้งทาํสมาธิควบคุมให้ค่า Meditation มีค่าถึง 70 ให้ไดภ้ายในระยะเวลา 20 วินาทีประตู

ถึงจะเปิด ส่วนค่า Time Since Last Packet คือ เวลาตัÊ งแต่ข้อมูลก่อนหน้าถึงข้อมูลทีÉ ส่งมาล่าสุดว่าให้

ระยะเวลาเท่าไรในการส่งขอ้มลูโดยส่วนมากจะใชเ้วลา 1 วนิาทีในการส่งขอ้มูล Meditation มา 1 ค่า 

จากตารางทีÉ 4.1 ตารางทีÉ 4.2 และตารางทีÉ 4.3 จะเป็นตารางแสดงผลการทดลองของแต่ละคน โดยใช้

การจบัเวลามาหาว่า ทีÉระยะ 2-10 เมตร แต่ละระยะทางจะใช้ระยะเวลาในการเปิดประตูนานเท่าไหร่ เมืÉอดู

จากตารางผลการทดลองแลว้สังเกตได้ว่าระยะทาง 2-10 เมตร ผูท้าํการทดลองแต่ละคนใช้เวลาในการเปิด

ประตูไม่ต่างกนัมาก ซึÉ งอยู่ในช่วง 37-50 วินาที โดยทีÉค่า PoorQuality มีค่าเป็น 0 คือสัญญาณมีความเสถียร

มากทีÉสุด ส่วนค่า Meditation จะมีค่าเท่ากบั 70 ประตูถึงเปิด และค่า Time Since Last Packet ระยะเวลาการ

ส่งขอ้มลู ขอ้มลูละประมาณ 1 วนิาที 

 

4.6 กล่าวท้ายบท 

จากตารางผลการทดลอง สรุปว่าภายในระยะทาง řŘ เมตร อุปกรณ์การเปิด-ปิดประตูยงัสามารถ

ทาํงานไดป้กติ สญัญาณคลืÉนไฟฟ้ามีความเสถียรและใชร้ะยะเวลาในการเปิดประตูไม่นานจนเกินไป แต่ทัÊงนีÊ

ยงัขึÊ นอยู่กับความเคยชินต่อการใช้อุปกรณ์ของแต่ละคน ว่าจะใช้ระยะเวลาในการเปิดประตูนานเท่าไร 

อย่างไรก็ตามงานวิจยันีÊ ไดแ้สดงให้เห็นความสําเร็จในการพฒันาโมดูลไมโครคอนโทรเลอร์ทีÉสามารถรับ

คาํสัÉงจากสัญญาณคลืÉนสมองเพืÉอนาํไปประยกุตใ์ชง้านไดท้างปฏิบติั 
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บททีÉ 5 สรุปและข้อเสนอแนะ 

 

5.1 สรุป 

โครงการวิจยัจึงเสนอแนวทางทีÉจะพฒันาโมดูลไมโครคอนโทรเลอร์ทีÉสามารถรับการสัÉงงานจากคลืÉน

สมองได้โดยตรง ทาํให้อุปกรณ์ หุ่นยนต์ หรือเครืÉองจกัรสามารถทาํงานได้ทันทีเมืÉอได้รับสัญญาณคลืÉน

สมองทีÉถูกตอ้ง การพฒันาโมดูลนีÊจะทาํให้เกิดการเชืÉอมต่อระหว่างสมองกบัอุปกรณ์โดยตรง ทีÉไม่ตอ้งผ่าน

เครืÉองคอมพิวเตอร์ หรือสามารถเรียกการเชืÉอมต่อนีÊว่า BDI (Brain-Devices Interface) การใช ้BDI นีÊ จะทาํ

ให้อุปกรณ์ หรือหุ่นยนต์สามารถทาํงานตามความตอ้งการของสมองไดโ้ดยตรง ซึÉ งจะเป็นกา้วต่อไปสู่การ

เปลีÉยนแปลงอุปกรณ์ต่างๆ ทีÉมีใหส้ามารถสัÉงงานผ่านสมองไดท้นัที และผูวิ้จยัจะใชไ้มโครคอนโทรเลอร์ทีÉ

หาซืÊอไดต้ามทอ้งตลาดทัÉวไป ราคาถูก ขนาดเลก็และประหยดัพลงังาน เพืÉอมารองรับการประมวลสัญญาณ

คลืÉนสมอง โดยพฒันาใหส้มองสามารถสัÉงการเปิด-ปิดประตูจาํลองได ้ทัÊงนีÊ จะเป็นการส่งสัญญาณโดยตรง

จากอุปกรณ์วดัสัญญาณสมองไปยงัไมโครคอนโทรเลอร์เพืÉอสัÉงมอเตอร์เปิด-ปิดทันทีโดยไม่ต้องผ่าน

คอมพิวเตอร์ 

อุปกรณ์ควบคุมการเปิด - ปิดประตูโดยใชค้ลืÉนไฟฟ้าสมอง EEG เป็นการพฒันาโปรแกรมของเครืÉอง

ตรวจวดัคลืÉนไฟฟ้าสมองมาใช้งานในชีวิตประจาํวนัดา้นการรักษาความปลอดภยัเนืÉองจากตวัเครืÉองสามารถ

ตรวจจบัความเปลีÉยนแปลงของคลืÉนไฟฟ้าสมองขณะทีÉเรามีความตัÊงใจทีÉจะทาํกิจกรรมบางอย่างและตอนทีÉ

เราเริÉมมีสมาธิ เครืÉองตรวจวดัคลืÉนไฟฟ้าสมองยงัสามารถตรวจจบัการกระพริบตาจากคลืÉนไฟฟ้าสมองไดเ้รา

จึงนาํการกระพริบตามาเป็นส่วนหนึÉงของการรักษาความปลอดภยัของการเขา้รหัสทีÉเราไดท้าํการโปรแกรม

ให้กบับอร์ด Arduino เนืÉองจากกลุ่มเราเล็งเห็นว่าการกระพริบตาจะเป็นการช่วยรักษาความปลอดภัยของ

ระบบ เพราะจะทาํใหผู้อื้ÉนทีÉไม่ใช่ผูที้É รู้รหัสสังเกตไดย้าก และหลงัจากการเขา้รหัสดว้ยการกระพริบตา เรา

จะตอ้งผ่านการเข้ารหสัแบบคลืÉนไฟฟ้าสมองอีกครัÊ งหนึÉงโดยผูเ้ขา้รหัสจะตอ้งทาํให้ค่า Meditation มีค่า şŘ

ขึÊนไป จากนัÊนตรวจสอบค่าให้ตรงกบัทีÉกาํหนดไวแ้ละอยู่ในระยะเวลาทีÉกาํหนดประตูถึงจะเปิดออก ถา้ไม่

สามรถทําให้ค่า Meditation ถึง şŘ ได้หรือระยะเวลาเกินทีÉกําหนดไว ้ระบบจะให้เรากลับไปเขา้รับการ

กระพริบตาเพืÉอยืนยนัการใชร้ะบบใหม่ 
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5.2 ปัญหาและข้อเสนอแนะ 

ř. มอเตอร์ปิดประตูเลืÉอน เลืÉอนเกินรางเฟือง สามารถแกไ้ข โดยปรับแรงดนัของมอเตอร์ใหต้ํÉาลง วดั

ระยะรางเฟืองใหม่ปรับใหพ้อดีกบัระยะทีÉเฟืองจะหมุนไปสุดราง 

Ś. การใส่รหสัผ่านดว้ยการกระพริบตานัÊนทาํไดย้าก เนืÉองจากจงัหวะและเวลาในการใส่รหสัแต่ละตวั

นัÊนค่อนขา้งสัÊน สามารถแกไ้ข  ทาํการเปลีÉยนค่า Delay เพืÉอทาํใหจ้บัจงัหวะทีÉจะใส่รหสัไดง่้ายขึÊนและ เพิÉม

หลอด LED เพืÉอบอกจงัหวะการใส่รหสัใหก้บัผูใ้ชง้าน 

3. Bluetooth ไม่ทําการเชืÉ อมต่อกับ Headset EEG สามารถแก้ไข  โดยก ารเข้าไป เช็ค ค่าทีÉ  AT 

Command และทําการตัÊ งค่าให้ Bluetooth เป็นMaster และจับเฉพาะ MAC Address ของ Headset EEG 

เท่านัÊน 

4. มีขอ้เสนอแนะคือ  อุปกรณ์เซ็นเซอร์ทีÉเชืÉอมต่อจากบอร์ด อาศยัแรงดนัไฟฟ้าและกระแสจาก

บอร์ดรวมถึงส่งสัญญาณทีÉมีค่าแรงดนัเฉพาะ ดงันัÊนเพืÉอความปลอดภยัต่อบอร์ด Arduino และตวัโมดูลทีÉใช้

ควรใชแ้รงดนัทีÉเหมาะสมกบัอปุกรณ์  

 

5.3 แนวทางการพฒันาในอนาคต 

งานวจิยัชิÊนนีÊ เป็นตน้แบบการใชง้านของคลืÉนไฟฟ้าสมองEEGในการนาํมาช่วยงานในชีวิตประจาํวนั

เพืÉอใช้ในการรักษาความปลอดภัยและยงัสามารถช่วยเหลือผูทุ้พพลภาพหรือผูป่้วยทีÉยงัสามารถใช้การ

กระพริบตาในการสืÉอสารได้ เช่น ผูป่้วยทีÉขยบัตัวไม่ได้แต่ยงัใช้การกระพริบตาได้ งานวิจยัชิÊนนีÊ จะเป็น

ตน้แบบในการพฒันาอุปกรณ์อืÉนๆทีÉจะช่วยให้ความสะดวกและความปลอดภัยในชีวิตประจาํวนัมากขึÊน

ประตู 
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